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Managing Events

You can use the Cisco Mobile Wireless Transport Manager (MWTM) to view information about all 
discovered events, including their associated network objects and other information.

This chapter includes:

• Viewing Basic Information for All Events, page 9-2

• Viewing Events for a Specific Object, page 9-8

• Setting an Event Filter, page 9-8

• Loading an Existing Event Filter, page 9-16

• Saving an Event Filter File, page 9-17

• Viewing Event Properties, page 9-18

• Attaching a Note to an Event, page 9-21

• Setting an Event Filter, page 9-8

• Viewing Archived Event Files on the Web, page 9-22

• Viewing the Event Metrics Report on the Web, page 9-23

• Changing the Way the MWTM Processes Events, page 9-27

• Forwarding Events as Traps to Other Hosts, page 9-40

• Setting Sounds for Events at an MWTM Client, page 9-41

• Displaying Alarms, page 9-46
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Viewing Basic Information for All Events
To view basic information for all events, click Events in the navigation tree of the MWTM in either the 
client interface or the web interface. The Event window appears.

Note The client interface provides right-click menu options, toolbar buttons, and user-customized column 
display of event data. The web interface provides some slightly different toolbar buttons and columns. 
Differences are noted in this section.

Figure 9-1 Event Window of the Client Interface

The Event window shows information about the events that the MWTM event logger and event processor 
deliver for all objects in the current network view.

Note You can view multiple Event windows at the same time, with different event filtering in each window or 
dialog box.

The Event window is composed of these sections:

• Event Toolbar Buttons, page 9-3

• Right-Click Menu for All Events, page 9-4

• Right-Click Menu for a Specific Event, page 9-4

• Event Table, page 9-5
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Event Toolbar Buttons
The Event window within the client and the Web may provide these toolbar buttons:

Button Description

Set Filter Opens the Event Filter dialog box.

Apply Filter

or

Remove Filter

Activates and deactivates the event filter specified in the Event Filter 
dialog box. If:

• The filter is activated, the MWTM shows only those events that 
pass the filter.

• The filter is deactivated, the MWTM shows all events.

• You activate a filter in an object’s Recent Events table in the 
MWTM main window, the filter is activated in all Recent Events 
tables in the MWTM main window for all other objects. The filter 
is not activated in Recent Events tables in Show In New Window 
windows or Real-Time Data and Charts windows.

Archived 
(Web interface only)

By default, the Recent Events table appears on the Web. Clicking on 
Archived shows the Archived Events table. Click the Archived button 
again to switch back and forth.

Pause

or

Resume

(Client interface only)

Pauses or resumes the table.

While the table is paused, the MWTM does not display new events in 
the table (unless you apply an event filter or edit your event 
preferences). When the table is resumed, all new events since the table 
was paused are added to the display.

If events are deleted while the table is paused, they are not removed 
from the table. Instead, they are grayed-out and cannot be 
acknowledged or edited. Deleted events are removed from the table 
when you resume the table.

Acknowledge

(Client interface only)

Makes the selected event or events acknowledged.

Unacknowledge

(Client interface only)

Makes the selected event or events unacknowledged.

Event Properties

(Client interface only)

Opens the Event Properties window.

Edit Notes

(Client interface only)

Opens the Edit Event dialog box.

Time Difference

(Client interface only)

Shows the time difference in days, minutes, hours, and seconds 
between two events.

Find

(Client interface only)

Finds specific text in the event table.

Create Sound Filter

(Client interface only)

Opens the Event Sound Filters dialog box and the Event Sound Filters 
List dialog box, with fields populated based on the selected event.
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Right-Click Menu for All Events

Note This feature is available only in the MWTM client interface.

To see the right-click menu for all events, select Events in the navigation tree left pane and click the 
right mouse button. The events right-click menu provides these options:

Right-Click Menu for a Specific Event

Note This feature is available only in the MWTM client interface.

The Event window provides a subset of the MWTM main menu as a right-click menu. To see this menu, 
select an event and click the right mouse button. The event right-click menu provides these options:

Adjust Row Height

(Client interface only)

Adjusts the table row height and wraps the message text. Click:

• Once to double the row height and wrap the message text.

• Again to triple the row height and wrap the message text.

• Again for single row height and no message text wrapping. This 
is the default setting.

This setting is saved automatically with your preferences.

Help for Event Shows context-sensitive help for the selected event in a separate 
browser window.

Button Description

Menu Command Description

Show In New Window Opens the Event window in a new window.

Back > List of Windows Navigates back to a window viewed in this session.

The MWTM maintains a list of up to 10 Back windows.

Forward > List of 
Windows

Navigates forward to a window viewed in this session.

The MWTM maintains a list of up to 10 Forward windows.

Menu Command Description

Edit Notes Opens the Edit Event dialog box for the selected event.

Go To > Object Shows the window for the object associated with the 
selected event.

If no object is associated with the event, this option is not 
visible.
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Event Table
The event table shows information about events that the MWTM event logger and event processor 
deliver.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
the MWTM shows all of the columns in the event table except Internal ID, Event Name, Element Name, 
Original Severity, Count, Note, Change Time, Change By, Ack By, Node, Card, SP, Linkset, Link, 
SGMP, ASP, AS, ASPA, Interface, or RAN Backhaul.

For more information about resizing, sorting, displaying, or hiding columns, see Navigating Table 
Columns, page 5-23.

To see detailed information about an event, right-click the event in a window, then select Event 
Properties in the right-click menu.

Note The Event table in the web interface displays fewer columns than the client interface. Only the Category, 
Severity, Create Time, and Severity columns appear in the web interface. Resizing and hiding columns 
and right-click menus are possible only in the client interface. 

Change Severity Changes the severity of the event. Severities include:

• Critical—The default color is red.

• Indeterminate—The default color is aqua.

• Informational—The default color is white.

• Major—The default color is orange.

• Minor—The default color is yellow.

• Normal—The default color is green.

• Warning—The default color is blue.

You can customize this field (see Changing Event 
Severities and Colors, page 9-35).

Acknowledge Makes the event acknowledged and records the user ID.

Unacknowledge Makes a previously acknowledged event unacknowledged.

Event Properties Opens the Event Properties window.

Create Sound Filter Opens the Event Sound Filters dialog box and the Event 
Sound Filters List dialog box, with fields populated based 
on the selected event.

Help for Event Shows context-sensitive help for the selected event in a 
separate browser window.

Menu Command Description
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Column Description

Internal ID Internal ID of the event. The internal ID is a unique ID for every object, that the 
MWTM assigns for its own internal use. This ID can also be useful when the Cisco 
Technical Assistance Center (TAC) is debugging problems.

Ack Indicates whether the event has been acknowledged. To:

• Acknowledge an unacknowledged event, use the Acknowledge toolbar button.

• Make a previously acknowledged event unacknowledged, use the 
Unacknowledge toolbar button.

Event Name Name of the event.

Element Name Network element name associated with the event.

Category Type of the event. Default values include:

• Create—Creation event, such as the creation of a seed file.

• Delete—Deletion event, such as the deletion of an object or file.

• Discover—Discovery event, such as Discovery beginning.

• Edit—Edit event. A user has edited an object.

• Ignore—Ignore event. A user has Ignored a link or linkset.

• Login—Login event. A user has logged in to the MWTM.

• LoginDisable—LoginDisable event. The MWTM has disabled a user’s 
User-Based Access authentication as a result of too many failed attempts to log 
in to the MWTM.

• LoginFail—LoginFail event. An attempt by a user to log in to the MWTM has 
failed.

• Logout—Logout event. A user has logged out of the MWTM.

• OverWrite—OverWrite event. An existing file, such as a seed file or route file, 
has been overwritten.

• Poll—Poll event, such as an SNMP poll.

• Purge—Purge event. A user has requested Discovery with Delete Existing Data 
selected, and the MWTM has deleted the existing the MWTM database.

• Status—Status change message generated.

• Trap—SNMP trap message generated.

You can customize this field (see Changing Event Categories, page 9-33).
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Severity Severity of the event. Default values include:

• Critical—The default color is red.

• Indeterminate—The default color is aqua.

• Informational—The default color is white.

• Major—The default color is orange.

• Minor—The default color is yellow.

• Normal—The default color is green.

• Warning—The default color is blue.

You can customize this field (see Changing Event Severities and Colors, page 9-35).

Original 
Severity

Original severity of the event.

Count Number of times this event occurred.

Note Indicates whether a note associated with the event.

Create Time Time this event was received.

Change Time Time this event was last updated.

Change By User who last changed this event.

Ack By If you have not implemented the MWTM User-Based Access, name of the node that 
last acknowledged the event.

If you have implemented the MWTM User-Based Access, name of the user who last 
acknowledged the event.

If no one has acknowledged the event, this field is blank.

Node Name of the node associated with the event. If no node is associated with the event, 
None appears.

Card (RAN-O 
only)

Card associated with this event.

SP (ITP only) Name of the signaling point associated with the event. If no signaling point is 
associated with the event, None appears.

Linkset (ITP 
only)

Name of the linkset associated with the event. If no linkset is associated with the 
event, None appears.

Link (ITP only) Name of the link associated with the event. If no link is associated with the event, 
None appears.

SGMP (ITP 
only)

Name of the signaling gateway-mated pair associated with the event. If no signaling 
gateway-mated pair is associated with the event, None appears.

ASP (ITP only) Name of the application server process associated with the event. If no application 
server process is associated with the event, None appears.

AS (ITP only) Name of the application server associated with the event. If no application server is 
associated with the event, None appears.

ASPA (ITP 
only)

Name of the application server process association associated with the event. If no 
application server process association is associated with the event, None appears.

Column Description
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Viewing Events for a Specific Object
You can use the MWTM to view events for a selected object. To do so, right-click an object (for example, 
a node) in a window, then choose View > Recent Events from the right-click menu. The MWTM shows 
recent events for the selected object (see Viewing Recent Events, page 8-44).

Setting an Event Filter
You can use the MWTM to change the way event information appears.

Note You can access the Event Filter dialog box through either the client interface or the web interface. Minor 
differences that exist are noted in this section.

To change the way the MWTM presents event information, click Events in the navigation tree, then click 
the Event Filter tool at the top of the Event window. The Event Filter dialog box appears with the 
Properties tab selected.

Figure 9-2 Event Filter Dialog, Showing Event Properties

Interface Interface associated with this event.

RAN Backhaul 
(RAN-O only)

RAN backhaul associated with this event.

Column Description
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For more information about the Event Filter dialog box, see these sections:

• Event Filter Buttons, page 9-9

• Properties Settings, page 9-9

• Selected Objects Settings, page 9-12

• Event Filter Example, page 9-15

Related Topics:

• Loading an Existing Event Filter, page 9-16

• Saving an Event Filter File, page 9-17

• Viewing Event Properties, page 9-18

Event Filter Buttons
The Event Filter dialog box contains:

Properties Settings
You use the Properties settings in the Event Filter dialog box to specify the types of event the MWTM 
should display in the Event window, including the category and severity of event, whether the event is 
acknowledged, and other properties.

To display the Properties settings, click the Properties tab in the Event Filter dialog box.

The Properties settings contain these panes:

• Categories, page 9-10

• Severities, page 9-11

• Other, page 9-11

Button Description

Select All Checks all check boxes in the section.

Deselect All Unchecks all check boxes in the section.

OK Applies any changes you made to the event filter and closes the Event Filter dialog 
box.

Load Opens the Load File Dialog: Load Filter, which you use to load an already existing 
event filter file.

If you are viewing events for a specific object in the navigation tree of the MWTM 
main window, this button is not available.

Save Opens the Save File Dialog: Save Filter, which you use to save the event filter file with 
a new name, or overwrite an existing event filter file.

If you are viewing events for a specific object in the navigation tree of the MWTM 
main window, this button is not available.

Cancel Closes the Event Filter dialog box without applying any changes to the event filter.

Help Shows online help for the current dialog box.
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Categories

Use the Categories pane of the Properties settings to specify which event categories you want to display 
in the Event window.

The Categories pane contains these default fields and buttons:

Note These are the default categories; there might be additional categories that the MWTM system 
administrator defines. For information about custom categories, see Changing Event Categories, page 
9-33.

Check Box Description

Status Indicates whether Status events appear in the Event window. The check box is 
checked by default.

Trap Indicates whether Trap events appear in the Event window. The check box is 
checked by default.

Create Indicates whether Create events appear in the Event window. The check box is 
checked by default.

Delete Indicates whether Delete events appear in the Event window. The check box is 
checked by default.

Discover Indicates whether Discover events appear in the Event window. The check box is 
checked by default.

Edit Indicates whether Edit events appear in the Event window. The check box is 
checked by default.

Ignore Indicates whether Ignore events appear in the Event window. The check box is 
checked by default.

Login Indicates whether Login events appear in the Event window. The check box is 
checked by default.

LoginDisable Indicates whether LoginDisable events appear in the Event window. The check box 
is checked by default.

LoginFail Indicates whether LoginFail events appear in the Event window. The check box is 
checked by default.

Logout Indicates whether Logout events appear in the Event window. The check box is 
checked by default.

OverWrite Indicates whether OverWrite events appear in the Event window. The check box is 
checked by default.

Poll Indicates whether Poll events appear in the Event window. The check box is 
checked by default.

Purge Indicates whether Purge events appear in the Event window. The check box is 
checked by default.
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Severities

Use the Severities pane of the Properties settings to specify which event severities you want to display 
in the Event window.

The Severities pane contains these default fields:

Note These are the default severities; there might be additional severities that the MWTM system 
administrator defines. For information about custom severities, see Changing Event Severities and 
Colors, page 9-35.

Other

Use the Other pane of the Properties settings to further define the event filter for the Event window. 
These settings are applied to all event displays in the current view.

Check box Description

Informational Indicates whether events of the specified severity appear in the Event window. 
Severities include:

• Informational

• Normal

• Indeterminate

• Warning

• Critical

• Minor

• Major

Note Check boxes are checked by default.

Normal

Indeterminate

Warning

Critical

Minor

Major

Field Description

Acknowledged Check box indicating whether only acknowledged events appear in the Event 
window. This check box is unchecked by default.

Unacknowledged Check box indicating whether only unacknowledged events appear in the 
Event window. This check box is checked by default.

Time Before Check box indicating whether only events that the MWTM logs prior to a 
specified date and time appear in the Event window. This check box is 
unchecked by default.

Time Before Specifies the date and time prior to which events that the MWTM logs appear 
in the Event window. This field is dimmed unless the Time Before check box 
is checked.

Time After Check box indicating whether only events that the MWTM logs after a 
specified date and time appear in the Event window. This check box is 
unchecked by default.
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Selected Objects Settings

Note The Selected Objects tab is not available in the Events dialog box if you are viewing events:

• For a specific object in the navigation tree of the MWTM main window.

• Using the web interface.

To specify an object for which the MWTM should display events in the Event window:

Step 1 Click Events in the navigation tree.

The Events window appears in the right pane.

Step 2 Click the Event Filter tool at the top of the Event window. 

The Event Filter dialog box appears with the Properties tab selected.

Step 3 Click the Selected Objects tab in the Event Filter dialog box. 

The Event Filter dialog box appears with the Selected Objects tab highlighted.

Time After Specifies the date and time after which events that the MWTM logs appear in 
the Event window. This field is dimmed unless the Time After check box is 
checked.

Message Contains Check box indicating whether only events that contain the specified message 
text appear in the Event window. This check box is unchecked by default.

Match Case Check box indicating whether only events that match the case of the text in the 
Message Contains field appear in the Event window. This field is dimmed 
unless the Message Contains check box is checked. If the Message Contains 
check box is checked, the default setting for this check box is unchecked.

Suppress events for 
unmanaged nodes

Check box for suppressing events for any objects that have been set to the 
unmanaged state (see Unmanaging and Managing Nodes or ITP Signaling 
Points, page 6-38, for steps to set an object to the unmanaged state). To 
suppress events for unmanaged objects, check the check box. To retain events 
for unmanaged objects, uncheck the check box.

If you are viewing events for a specific object in the navigation tree of the 
MWTM main window, this button is not available.

Field Description
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Figure 9-3 Event Filter Dialog, Showing Event Selected Objects

The Selected Objects settings contains:

Field or Button Description

Node Drop-down list box of all nodes that the MWTM has discovered. If you:

• Want to filter events based on a node, select a node from the 
drop-down list box.

• Do not want to filter events based on a node, select None. The 
MWTM grays-out the other object fields. This is the default 
setting.

ApplicationServerProcess 
(ITP only)

Drop-down list box of all application server processes associated with 
the selected node:

• If you want to filter events based on an application server process, 
select an application server process from the drop-down list box.

• If you do not want to filter events based on an application server 
process, select None. This is the default setting.

SignalingGatewayMatedPair 
(ITP only)

Drop-down list box of all signaling gateway-mated pairs associated 
with the selected node:

• If you want to filter events based on a signaling gateway-mated 
pair, select a signaling gateway-mated pair from the drop-down list 
box.

• If you do not want to filter events based on a signaling 
gateway-mated pair, select None. This is the default setting.



 

9-14
User Guide for the Cisco Mobile Wireless Transport Manager 6.0

OL-9118-03

Chapter 9      Managing Events
  Setting an Event Filter

SignalingPoint (ITP only) Drop-down list box of all signaling points associated with the selected 
node:

• If you want to filter events based on a signaling point, select a 
signaling point from the drop-down list box.

• If you do not want to filter events based on a signaling point, select 
None. This is the default setting.

Linkset (ITP only) Drop-down list box of all linksets associated with the selected 
signaling point:

• If you want to filter events based on a linkset, select a linkset from 
the drop-down list box.

• If you do not want to filter events based on a linkset, select None. 
This is the default setting.

Link (ITP only) Drop-down list box of all links associated with the selected linkset:

• If you want to filter events based on a link, select a link from the 
drop-down list box.

• If you do not want to filter events based on a link, select None. This 
is the default setting.

ApplicationServer (ITP only) Drop-down list box of all application servers associated with the 
selected signaling point:

• If you want to filter events based on an application server, select an 
application server from the drop-down list box.

• If you do not want to filter events based on an application server, 
select None. This is the default setting.

ApplicationServerProcess
Association (ITP only)

Drop-down list box of all application server process associations 
associated with the selected application server:

• If you want to filter events based on an application server process 
association, select an application server process association from 
the drop-down list box.

• If you do not want to filter events based on an application server 
process association, select None. This is the default setting.

Card (RAN-O only) Drop-down list box of all cards associated with the selected node:

• If you want to filter events based on a card, select a card from the 
drop-down list box.

• If you do not want to filter events based on a card, select None. 
This is the default setting.

Interface Drop-down list box of all interfaces (including subinterfaces) 
associated with the selected node or card:

• If you want to filter events based on an interface, select an interface 
from the drop-down list box.

• If you do not want to filter events based on an interface, select 
None. This is the default setting.

Field or Button Description
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Event Filter Example
This example shows how to set an event filter to display trap messages for warning events for a specific 
node.

Step 1 Choose Events in the navigation tree of the MWTM main window of the client interface.

Step 2 Click the Event Filter tool at the top of the Event window. 

The Event Filter dialog box appears with the Properties tab selected.

Step 3 In the Categories pane, uncheck all check boxes except for the Trap check box.

Step 4 In the Severities pane, uncheck all check boxes except for the Warning check box.

Step 5 Click the Selected Objects tab.

Step 6 In the drop-down list box, choose a node from the list of discovered nodes.

Backhaul (RAN-O only) Drop-down list box of all RAN backhauls associated with the selected 
node or card:

• If you want to filter events based on an interface, select an interface 
from the drop-down list box.

• If you do not want to filter events based on an interface, select 
None. This is the default setting.

Selected Objects: Object 
Type

Indicates the type of object, if any, on which the event filter is based.

Selected Objects: AS (ITP 
only)

Indicates the application server, if any, on which the event filter is 
based.

Selected Objects: ASP (ITP 
only)

Indicates the application server process, if any, on which the event filter 
is based.

Selected Objects: ASPA (ITP 
only)

Indicates the application server process application, if any, on which 
the event filter is based.

Selected Objects: Link (ITP 
only)

Indicates the link, if any, on which the event filter is based.

Selected Objects: Linkset 
(ITP only)

Indicates the linkset, if any, on which the event filter is based.

Selected Objects: Node Indicates the node, if any, on which the event filter is based.

Selected Objects: SGMP (ITP 
only)

Indicates the signaling gateway-mated pair, if any, on which the event 
filter is based.

Selected Objects: SP (ITP 
only)

Indicates the signaling point, if any, on which the event filter is based.

Selected Objects: Card 
(RAN-O only)

Indicates the card, if any, on which the event filter is based.

Selected Objects: Interface Indicates the interface or subinterface, if any, on which the event filter 
is based.

Selected Objects: Backhaul 
(RAN-O only)

Indicates the RAN backhaul, if any, on which the event filter is based.

Field or Button Description
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Step 7 To activate the event filter and close the Event Filter dialog box, click OK.

Step 8 To save the event filter for future use:

a. In the Event Filter dialog box, click Save. This action opens the Save Filter dialog box.

b. In the Save Filter dialog box, enter a meaningful name in the Filename text box (for example, 
Node109-WarningTraps).

c. Click OK to close the Save Filter dialog box.

d. Click OK to close the Event Filter dialog box.

In the future, to view traps for warning events for Node109, click Load in the Event Filter dialog 
box, choose the Node109-WarningTraps filter, then click OK. The Events window will only display 
warning traps for Node109 until you load a different event filter or change the current one. 

Loading an Existing Event Filter
You use the MWTM to load a specific event filter file and change the list of event filter files.

To load an existing event filter, click Load in the Event Filter dialog box. The Load File Dialog: Load 
Filter dialog box appears.

Figure 9-4 Load File Dialog: Load Filter Dialog

The Load File Dialog: Load Filter contains:

Field or Button or Icon Description

Type Icon indicating whether the item in the table is a file or a folder.

Name Name of the event filter file or folder.

Last Modified Date and time the event filter file or folder was last modified.

Size (bytes) Size of the event filter file or folder, in bytes.

Number of Files
(appears in lower -eft corner)

Total number of event filter files and folders.
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Saving an Event Filter File
You use the MWTM to save a specific event filter file and change the list of event filter files.

When you are satisfied with the filter settings, click Save in the Event Filter dialog box. The Save File 
Dialog:Save Filter dialog box appears.

Figure 9-5 Save File Dialog: Save Filter Dialog

The Save File Dialog: Save Filter contains:

OK Loads the selected event filter, saves any changes you made to the 
list of files, and closes the dialog box.

To load an event filter file, double-click it in the list, select it in 
the list and click OK, or enter the name of the file and click OK. 
The MWTM loads the event filter file, saves any changes you 
made to the list of files, closes the Load File Dialog: Load Filter 
dialog box, and returns to the Event Filter dialog box.

Delete Deletes the selected file from the event filter file list. The MWTM 
issues an informational message containing the name and location 
of the deleted file.

Cancel Closes the dialog box without loading an event filter file or saving 
any changes to the event filter file list.

Help Shows online help for the dialog box.

Field or Button or Icon Description

Field or Button or Icon Description

Type Icon indicating whether the item in the table is a file or a folder.

Name Name of the event filter file or folder.

Last Modified Date and time the event filter file or folder was last modified.

Size (bytes) Size of the event filter file or folder, in bytes.
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Viewing Event Properties
You use the MWTM to view detailed information about a selected event, including its associated object, 
status, and other information.

To view detailed information about an event, right-click the event in a window, then select Event 
Properties in the right-click menu.

The Event Properties dialog box appears.

Filename Name by which you want to save the event filter file.

If you create a new event filter filename, you can use any letters, 
numbers, or characters in the name that are allowed by your 
operating system. However, if you include any spaces in the new 
name, the MWTM converts those spaces to dashes. For example, 
the MWTM saves file a b c as a-b-c.

Number of Files
(displayed in bottom left corner)

Total number of event filter files and folders.

OK Saves any changes you made to the current event filter file and 
closes the dialog box.

To save the event filter file with a new name, use one of these 
procedures. To save the file with:

• A completely new name, enter the new name and click OK.

• An existing name, overwriting an old event filter file, select 
the name in the list and click OK.

The MWTM saves the event filter file with the new name, saves 
any changes you made to the list of files, closes the Save File 
Dialog: Save Filter dialog box, and returns to the Event Filter 
dialog box.

Delete Deletes the selected file from the event filter file list. The MWTM 
issues an informational message containing the name and location 
of the deleted file.

Cancel Closes the dialog box without saving the event filter file or saving 
any changes to the event filter file list.

Help Shows online help for the dialog box.

Field or Button or Icon Description
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Figure 9-6 Event Properties Dialog

The Event Properties dialog box contains:

Tab, Field, or Button Description

Properties Tab that shows detailed information about the selected event.

Message Message text for the event.

You can customize this field (see Changing the Way the MWTM Processes 
Events, page 9-27).

Category Type of the event. Default values are:

• Create—Creation event, such as the creation of a seed file.

• Delete—Deletion event, such as the deletion of an object or file.

• Discover—Discovery event, such as Discovery beginning.

• Edit—Edit event. A user has edited an object.

• Ignore—Ignore event. A user has ignored a link or linkset.

• Login—Login event. A user has logged in to the MWTM.

• LoginDisable—LoginDisable event. The MWTM has disabled a user’s 
User-Based Access authentication as a result of too many failed attempts 
to log in to the MWTM.

• LoginFail—LoginFail event. A user’s attempt to log in to the MWTM has 
failed.

• Logout—Logout event. A user has logged out of the MWTM.
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Category (continued) • OverWrite—OverWrite event. An existing file, such as a seed file or route 
file, has been overwritten.

• Poll—Poll event, such as an SNMP poll.

• Purge—Purge event. A user has requested Discovery with Delete Existing 
Data selected, and the MWTM has deleted the existing MWTM database.

• Status—Status change message generated.

• Trap—SNMP trap message generated.

You can customize this field (see Changing Event Categories, page 9-33).

Severity Severity of the event. Default values are:

• Critical—The default color is red.

• Indeterminate—The default color is aqua.

• Informational—The default color is white.

• Major—The default color is orange.

• Minor—The default color is yellow.

• Normal—The default color is green.

• Warning—The default color is blue.

You can customize this field (see Changing Event Severities and Colors, page 
9-35).

Timestamp Date and time the event was logged.

Message Name User-specified message name for the event that the MWTM uses for trap 
forwarding. The default message name is MWTM.

For more information about user-specified message names and trap 
forwarding, see Forwarding Events as Traps to Other Hosts, page 9-40.

Acknowledged Indicates whether the event has been acknowledged.

Acknowledged By Name of the node that last acknowledged the event. If no one has 
acknowledged the event, this field is blank.

Ack Timestamp Date and time the event was last acknowledged or unacknowledged.

Node Name of the node associated with the event. If no node is associated with the 
event, None appears.

Signaling Point (ITP 
only)

Name of the signaling point associated with the event. If no signaling point is 
associated with the event, None appears.

Linkset (ITP only) Name of the linkset associated with the event. If no linkset is associated with 
the event, None appears.

Link (ITP only) Name of the link associated with the event. If no link is associated with the 
event, None appears.

AS (ITP only) Name of the application server associated with the event. If no application 
server is associated with the event, None appears.

ASP (ITP only) Name of the application server process associated with the event. If no 
application server process is associated with the event, None appears.

Tab, Field, or Button Description
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Related Topic:

Viewing Basic Information for All Events, page 9-2

Attaching a Note to an Event
You use the MWTM to annotate an event, attaching a descriptive string to the event.

To annotate an event, right-click an event in the Event window, then select Edit Notes in the right-click 
menu.

The Edit Event dialog box appears.

Figure 9-7 Edit Event Dialog

ASPA (ITP only) Name of the application server process association associated with the event. 
If no application server process association is associated with the event, None 
appears.

SGMP (ITP only) Name of the signaling gateway-mated pair associated with the event. If no 
signaling gateway-mated pair is associated with the event, None appears.

Rtr Interface Name of the interface associated with the event.

Ran Backhaul 
(RAN-O only)

Name of the RAN backhaul associated with the event.

Card (RAN-O only) Name of the card associated with the event. 

Notes Tab that shows notes associated with this event.

Last Update Date and time the Notes field for this event was last updated. If no note is 
currently associated with this event, this field shows the value Not Set.

Notes Notes associated with this event. If no note is currently associated with this 
event, this field shows the value No Notes.

Close Closes the Event Properties dialog box.

Details Tab that shows specific event attributes.

Tab, Field, or Button Description
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The Edit Event dialog box contains:

Related Topics:

• Viewing Basic Information for All Events, page 9-2

• Viewing Event Properties, page 9-18

Viewing Archived Event Files on the Web
The All Network Event Archived Files page provides access to archived event files within ITP or RAN-O 
networks for the server to which you are connected.

To access archived event files:

Step 1 Within a Web browser, navigate to the MWTM web interface (for details, see Accessing the MWTM Web 
Interface, page 11-1).

Step 2 Choose File Archive > Events from the Web navigation tree.

Within the Last Modified Date column, choose the day you want to view archived event files for.

Step 3 Adjacent to the date you have chosen, click on the Status Changes and SNMP Traps link under View. 
The Network Status Archive page appears, showing a list of the status and trap messages in the archive.

Field or Button Description

Name Message text of the event.

Last Update Date and time the Notes field for this event was last updated. If no note is currently 
associated with this event, this field shows the value Not Set.

You cannot edit this field.

Notes Notes to associate with this event. In this field, you can enter any important 
information about the event, such as its associated object, what triggered the event, 
how often it has occurred, and so on.

Save Saves changes you have made to the event information and exits the Edit Event 
dialog box.

Cancel Exits the Edit Event dialog box without saving any changes.

Help Shows online help for the current window.
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Viewing the Event Metrics Report on the Web
The Event Metrics Report page shows a number of metrics for the MWTM, based on the number of 
messages of each type and severity that the MWTM receives. This report is applicable for both ITP and 
RAN-O networks.

To view the event metrics report using the MWTM Web interface:

Step 1 Within a Web browser, navigate to the MWTM Web interface (for details, see Accessing the MWTM 
Web Interface, page 11-1).

Step 2 Click Reports > Statistics > Events, or from the Reports page, click Events.

The Event Metrics Report page contains the following tables:

• Message Types Table, page 9-23

• Message Severity Table, page 9-24

• Status Messages Table, page 9-24

• Trap Messages Table, page 9-25

• Messages/Day Table, page 9-26

• Status Change Messages/Day Table, page 9-26

• SNMP Trap Messages/Day Table, page 9-26

• Files Processed Table, page 9-27

• Date Range Table, page 9-27

Message Types Table
The Message Types table contains the following columns:

Column Description

Message Types Total number of messages of each type that the MWTM received. Possible types are:

• Total Messages—Total number of messages of all types

• Total Status—Total number of status change messages

• Total Traps—Total number of SNMP trap messages

Num Number of messages of each type that the MWTM received.

Num/Total Number of messages of a given type that the MWTM received, divided by the total 
number of messages that the MWTM received, shown as a percentage.
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Message Severity Table
The Message Severity table contains the following columns:

Status Messages Table
The Status Messages table contains the following columns:

Column Description

Message 
Severity

Total number of messages (status change messages and SNMP trap messages) of each 
severity that the MWTM received:

• Total Warning

• Total Normal

• Total Unclass

• Total Minor

• Total Major

• Total Informational

• Total Error

• Total Critical

• Total Admin

Num Number of messages of each severity that the MWTM received.

Num/Total Number of messages of a given severity that the MWTM received, divided by the total 
number of messages that the MWTM received, shown as a percentage.

Column Description

Status 
Messages

Total number of status change messages of each severity that the MWTM received. 
Possible severities are:

• Status Minor

• Status Normal

• Status Major

• Status Warning

• Status Informational

• Status Critical

• Status Unclass

• Status Error

• Status Admin

Num Number of status change messages of each severity that the MWTM received.
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Trap Messages Table
The Trap Messages table contains the following columns:

Num/Status Number of status change messages of a given severity that the MWTM received, 
divided by the total number of status change messages that the MWTM received, 
shown as a percentage.

Num/Total Number of status change messages of a given severity that the MWTM received, 
divided by the total number of messages (status change messages and SNMP trap 
messages) that the MWTM received, shown as a percentage.

Column Description

Column Description

Trap Messages Total number of SNMP trap messages of each severity that the MWTM received. 
Possible severities are:

• Trap Warning

• Trap Unclass

• Trap Normal

• Trap Minor

• Trap Major

• Trap Informational

• Trap Error

• Trap Critical

• Trap Admin

Num Number of SNMP trap messages of each severity that the MWTM received.

Num/Trap Number of SNMP trap messages of a given severity that the MWTM received, 
divided by the total number of SNMP trap messages that the MWTM received, shown 
as a percentage.

Num/Total Number of SNMP trap messages of a given severity received by the MWT, divided 
by the total number of messages (status change messages and SNMP trap messages) 
that the MWTM received, shown as a percentage.
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Messages/Day Table
The Messages/Day table contains the following columns:

Status Change Messages/Day Table
The Status Change Messages/Day table contains the following columns:

SNMP Trap Messages/Day Table
The Status Change Messages/Day table contains the following columns:

Column Description

Day Date for which metrics are calculated.

NumMsgs Total number of messages that the MWTM received on a given day.

NumMsgs/TotalMsgs Number of messages that the MWTM received on a given day, divided by the 
total number of messages (status change messages and SNMP trap messages) 
that the MWTM received on all days, shown as a percentage.

Column Description

Day Date for which metrics are calculated.

NumStatMsgs Total number of status change messages that the MWTM received 
on a given day.

NumStatMsgs/TotalMsgs Number of status change messages that the MWTM received on a 
given day, divided by the total number of messages (status change 
messages and SNMP trap messages) that the MWTM received on all 
days, shown as a percentage.

NumStatMsgs/TotalStatMsgs Number of status change messages that the MWTM received on a 
given day, divided by the total number of status change messages 
that the MWTM received on all days, shown as a percentage.

Column Description

Day Date for which metrics are calculated.

NumTrapMsgs Total number of SNMP trap messages that the MWTM received 
on a given day.

NumTrapMsgs/TotalMsgs Number of SNMP trap messages that the MWTM received on a 
given day, divided by the total number of messages (status change 
messages and SNMP trap messages) that the MWTM received on 
all days, shown as a percentage.

NumTrapMsgs/TotalTrapMsgs Number of SNMP trap messages that the MWTM received on a 
given day, divided by the total number of SNMP trap messages 
that the MWTM received on all days, shown as a percentage.
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Files Processed Table
The Files Processed table lists all files that the MWTM has processed.

Date Range Table
The Date Range table displays the date and time when the MWTM began collecting metrics, and the date 
and time of the most recent metrics.

Changing the Way the MWTM Processes Events
The three types of MWTM events are:

• Trap events—Incoming events that the MWTM does not solicit

• Status events—Status changes that the MWTM detects

• User Action events—Events that user actions trigger

Within those broad types, there occur subordinate types of events, each with a default category, severity, 
color, message text, and event help file. You use the MWTM to change the default characteristics of each 
type of event, tailoring them to meet your needs.

Note Changes you make to the MWTM event processing can adversely affect your operating environment. In 
most environments, the MWTM recommends that you use the default event-processing settings without 
modification.

To change the MWTM event processing, use one of these procedures:

• Choose Tools > Event Editor from the MWTM main menu.

• Choose Start > Programs > Cisco MWTM Client > MWTM Event Editor in Windows.

• Enter the mwtm eventeditor command (see mwtm eventeditor, page B-22).

The MWTM launches the MWTM Event Editor.
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Figure 9-8 MWTM Event Editor

You use the Event Editor to customize the visible category, severity, color, and message associated with 
events; and load, save, and deploy customized event configurations. You can also specify a list of SNMP 
servers to which the MWTM should forward events in the form of traps.

The high-level MWTM event processing settings appear in the navigation tree in the left pane in the 
MWTM Event Editor window. The detailed settings for each high-level setting appear in the content area 
in the right pane.

The MWTM Event Editor menu provides these options:

Menu Command Description

File > Load Draft Loads the local copy of the event configuration that you saved.

File > Save Draft
(Ctrl-S)

Saves a local copy of the event configuration, including any changes you 
made by using the Event Editor. You can save only one local copy of the event 
configuration. You cannot specify a filename for the local copy.

File > Load Default Loads the default event configuration on this MWTM client.

The default event configuration is the standard event configuration that the 
MWTM uses when it is first installed. The default event configuration stored 
on the MWTM server and shared by all MWTM clients, but the clients cannot 
modify it.

File > Load Running Loads the event configuration that is currently running on the MWTM server.

File > Load Backup Loads the backup event configuration from the MWTM server.

The MWTM creates a backup event configuration every time the event 
configuration on the MWTM server is overwritten.

File > Revert Reverts to the last event configuration that was loaded on the MWTM client. 
This could be the draft, default, running, or backup event configuration.
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This section provides this information:

• Changing Event Limits, page 9-30

• Specifying a List of SNMP Servers for Trap Forwarding, page 9-32

• Changing Event Categories, page 9-33

• Changing Event Severities and Colors, page 9-35

• Configuring Trap, Status Alarm, or User Action Events, page 9-36

File > Deploy Deploys the event configuration that is currently being edited on this MWTM 
client to the MWTM server.

The deployed event configuration does not take effect until you restart the 
MWTM server. When you restart the MWTM server, the MWTM 
automatically reflects your changes to the event configuration on the MWTM 
server and on all MWTM clients that connect to that server, and reflects any 
new or changed categories, severities, and other event characteristics in its 
web navigation bars.

File > Exit Closes the Event Editor window. If you have made any changes to the event 
configuration, the MWTM asks if you want to save the changes before leaving 
the window. Click:

• Save Draft to save the changes in a local copy of the event configuration. 
You can save only one local copy of the event configuration. You cannot 
specify a filename for the local copy.

• Deploy to deploy the event configuration, including any changes you 
made, to the MWTM server.

The deployed event configuration does not take effect until you restart 
the MWTM server. When you restart the MWTM server, the MWTM 
automatically reflects your changes to the event configuration on the 
MWTM server and on all MWTM clients that connect to that server, and 
reflects any new or changed categories, severities, and other event 
characteristics in its web display navigation bars.

• No or Cancel to close the prompt window and return to the Event Editor 
window.

Help > Topics
(F1)

Shows the table of contents for the MWTM online help.

Help > Window
(Shift-F1)

Shows online help for the current window.

Help > About
(F3)

Shows build date, version, SSL support, and copyright information about the 
MWTM application.

Menu Command Description
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Changing Event Limits
To change limits for the MWTM event database, select the turner beside Event Configuration, then click 
Limits. The Limits Configuration window appears in the right pane.

Field Description

MaxEventDbRecords Sets the maximum number of events allowed in the in-memory 
database. You can observe these events in the client NBAPI. The 
MWTM archives deleted events.

By default, the MWTM event database can hold a maximum of 5,000 
events. If the database exceeds 5,000 events, the MWTM deletes the 
oldest events until the database is reduced to 5,000 events.

To change the size of the MWTM event database, enter the new size, 
in number of events, in this field. The valid range is 0 events (that is, 
no limit) to an unlimited number of events. The default setting is 
5,000 events.

Note As you increase the size of the event database, you negatively 
impact the performance of the MWTM server and clients is 
impacted.

MaxEventTimeToLive Sets the maximum length of time, in days, the MWTM should retain 
events in the in-memory database.You can observe these events in the 
client NBAPI. The MWTM archives deleted events.

By default, the MWTM event database retains events a maximum of 
7 days. The MWTM deletes events that are older than 7 days.

To change the maximum age for events, enter the new age, in days, in 
this field. The valid range is 0 days (events are purged at each 
maintenance interval) to an unlimited number of days. The default 
setting is 7 days.

CompressEventDbInterval Sets the length of time, in minutes, between maintenance checks of the 
in-memory database. The MWTM archives these events when this 
task runs. Also, the oldest archived events may be deleted from the 
database.

By default, the MWTM performs maintenance on the event database 
every 15 minutes, deleting all events in excess of 5000 and all events 
older than 7 days.

To change the maintenance interval, enter the new interval, in minutes, 
in this field. The valid range is 0 minutes (perform continual 
maintenance; not advised) to an unlimited number of minutes. The 
default setting is 60 minutes.

Note The smaller the maintenance interval, the greater the negative 
impact on the performance of the MWTM server and clients.
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AutomationTimeout Sets the maximum length of time, in seconds, the MWTM should 
allow an event automation script to run.

By default, the MWTM event database allows an event automation 
script to run for 300 seconds (5 minutes) before canceling the script 
and moving on.

To change the event automation timeout interval, enter the new 
interval, in seconds, in this field. The valid range is 0 seconds (no 
automation) to an unlimited number of seconds. The default setting is 
300 seconds.

Note The MWTM runs each automation script sequentially, not in 
parallel. Therefore, the longer the automation timeout 
interval, the greater the chance that a failed script can delay 
subsequent scripts.

ProcessUndiscovered Determines whether the MWTM should process events from 
undiscovered nodes:

• False—Do not process events from undiscovered nodes. This 
setting is the default.

• True—Begin processing events from undiscovered nodes.

Send Updates Determines whether the MWTM should send traps northbound:

• False—Do not send traps northbound when an event is updated or 
deleted. Only send traps when an event is new. This setting is the 
default.

• True—Send traps northbound when an event is updated, deleted, 
or new.

ProcessUnrecognizedTraps Determines whether the MWTM should create events for 
unrecognized traps:

• False—(Default setting) Do not create events for unrecognized 
traps.

• True—Create events for unrecognized traps. This setting is the 
default.

TrapGenThrottle A delay (in milliseconds) between each trap sent to a northbound host. 
This value is helpful if the MWTM is sending traps faster than the 
northbound host can receive them. The default is 10 milliseconds.

HeartbeatTrapInterval A delay (in seconds) between each heartbeat trap sent to a northbound 
host. If this value is zero or less than one, no heartbeat trap is sent. The 
default is 0.

ArchiveAge The maximum age, in days, of all archived events and alarms in the 
database. The default is 31 days.

MaxAlarmAge The maximum age, in days, of all active alarms in the database. The 
default is 7 days.

Field Description
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Specifying a List of SNMP Servers for Trap Forwarding
You use the MWTM to specify a list of SNMP servers, or hosts, to which the MWTM should forward 
events in the form of traps.

For more information about enabling MWTM trap forwarding, see Forwarding Events as Traps to Other 
Hosts, page 9-40.

To specify the list of hosts, select the turner beside Event Configuration, then click SNMP Servers. The 
SNMP Servers Configuration window appears in the content area in the right pane.

CloneAlarms Determines whether the MWTM should create separate alarm 
instances from underlying events: 

• False—No alarms are created. 

• True—Alarms are created from underlying events. This setting is 
the default. 

AllowEventDeduplication Determines whether the MWTM should eliminate redundant 
(duplicate) events if a correlation key has been specified and enabled:

• False—The MWTM does not eliminate duplicate alarms. This 
setting is the default.

• True—The MWTM eliminates duplicate alarms. 

AllowStateAggregation Determines whether the MWTM should allow alarms to change the 
state of the node:

• False—Alarms will not affect the node state. 

• True—Alarms will affect the node state. This setting is the 
default.

ClearedAlarmsTimetoLive The time, in minutes, before the MWTM archives cleared alarms.

SendEvents Determines whether the MWTM should send events to a northbound 
system:

• False—Does not send events to the northbound system.

• True—Sends events to the northbound system. This setting is the 
default.

SendAlarms Determines whether the MWTM should send alarms to a northbound 
system:

• False—Does not send alarms to the northbound system. This 
setting is the default.

• True—Sends alarms to the northbound system. 

Field Description

Field or Button Description

Host Name of the host NMS that should receive traps from the MWTM. The host must 
be IP-routable, and the name must be a valid IP address or DNS name.

Port Host port number to which the MWTM should forward traps.

Community SNMP community string that the MWTM should include in forwarded traps.
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Changing Event Categories
To change categories for the MWTM event database, click the turner beside Event Configuration, then 
click Categories. The Categories Configuration window appears in the content area in the right pane.

Version Trap version to forward. Valid values are 1 and 2c.

Trap Type Type of trap that the MWTM should forward to this host. Valid trap types are:

• CISCO-SYSLOG: The CISCO-SYSLOG-MIB clogMessageGenerated trap.

• CISCO-EPM-NOTIFICATION: CISCO-EPM-NOTIFICATION-MIB 
ciscoEpmNotificationRev1 trap.

Add Adds a new hostname to the bottom of the list. Type over the default values with 
the new values.

Delete Deletes the selected hostname from the list.

Send a trap for all 
events

Checks the Send Traps check box for all MWTM events. Click this button if you 
want the MWTM to forward all events to the list of hosts.

If you click this radio button, and then you uncheck even a single Send Traps 
check box for any event, the MWTM unchecks this button.

This radio button is mutually exclusive with the Send a trap for no events 
button.

Send a trap for no 
events

Unchecks the Send Traps check box for all MWTM events. Click this button if 
you do not want the MWTM to forward any events to the list of hosts. This is the 
default setting.

If you click this radio button, and then you check even a single Send Traps check 
box for any event, the MWTM unchecks this button.

This radio button is mutually exclusive with the Send a trap for all events 
button.

Field or Button Description

Field or Button Description

Category Name Lists the names of the currently defined MWTM event categories.

By default, the MWTM provides these event categories:

• Status—Status change message generated.

• Trap—SNMP trap message generated.

• Create—Creation event, such as the creation of a seed file.

• Delete—Deletion event, such as the deletion of an object or file.

Category Name

(continued)

• Discover—Discovery event, such as Discovery beginning.

• Edit—Edit event. A user has edited an event, linkset, or node.

• Ignore—Ignore event. A user has Ignored a link or linkset.
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Category Name

(continued)

• Login—Login event. A user has logged in to the MWTM.

• LoginDisable—LoginDisable event. The MWTM has disabled a user’s 
User-Based Access authentication as a result of too many failed attempts to 
log in to the MWTM.

• LoginFail—LoginFail event. An attempt by a user to log in to the MWTM 
has failed.

• Logout—Logout event. A user has logged out of the MWTM.

• OverWrite—OverWrite event. An existing file, such as a seed file or route 
file, has been overwritten.

• Poll—Poll event, such as an SNMP poll.

• Purge—Purge event. A user has requested Discovery with Delete Existing 
Data selected, and the MWTM has deleted the existing the MWTM database.

To change the name of an existing event category, highlight the category name 
and type over it with the new name. For example, you could replace every 
occurrence of LoginFail with BadLogin.

Add Adds a new category name to the bottom of the list. Type over the default 
category name with the new name.

Delete Deletes the selected category name from the list.

If events in the MWTM database use the deleted category name, the Entry 
Substitution dialog box appears. Use this dialog box to select a new category 
name in place of the deleted category name. Select an existing category name 
from the drop-down list box, or enter a new category name. If you enter a new 
category name, the MWTM adds it to the Category Name field.

Field or Button Description
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Changing Event Severities and Colors
To change severities or colors for the MWTM event database, select the turner beside Event 
Configuration, then click Severities. The Severities Configuration window appears in the content area 
in the right pane.

Field or Button Description

Severity Name Lists the names of the currently defined MWTM event severities.

By default, the MWTM provides these event severities:

• Informational

• Normal

• Indeterminate

• Warning

• Critical

• Minor

• Major

To change the name of an existing event severity, highlight the severity name and type 
over it with the new name. For example, you could replace every occurrence of 
Normal with Clean.

Severity Color Lists the colors of the currently defined MWTM event severities.

By default, the MWTM provides these event colors:

• Informational—The default color is white.

• Normal—The default color is green.

• Indeterminate—The default color is aqua.

• Warning—The default color is blue.

• Critical—The default color is red.

• Minor—The default color is yellow.

• Major—The default color is orange.

To change the color associated with an existing severity, select the current color, then 
select a new color from the drop-down list box. For example, you can display Warning 
events in maroon instead of yellow.

Add Adds a new severity name to the bottom of the list. Type over the default severity 
name with the new name, then select a color from the drop-down list box. The default 
color is white.

Delete Deletes the selected severity name from the list.

If events in the MWTM database use the deleted severity name, the Entry Substitution 
dialog box appears. Use this dialog box to select a new severity name in place of the 
deleted severity name. Select an existing severity name from the drop-down list box, 
or enter a new severity name. If you enter a new severity name, the MTWM adds it to 
the Severity Name field.
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Configuring Trap, Status Alarm, or User Action Events
The MWTM can detect these event types:

• Traps—Events that are triggered by SNMP traps or notifications

• Status Alarms—Events that are triggered by status changes

• User Actions—Events that are triggered by user actions

To configure the event parameters for any of these event types:

Step 1 Choose Tools > Event Editor from the MWTM main menu.

Step 2 Select the turner beside Event Configuration.

Step 3 Select the turner beside the event type that you want to configure (Traps, Status Alarms, or User 
Actions). 

The MWTM lists the currently defined events in the navigation tree under the event type.

Step 4 To add an event to an event type, right-click the event type and select Add from the right-click menu. 

The MWTM opens the Add Entry dialog box, which lists the events that the MWTM supports but have 
not yet been configured. 

Step 5 Select an event that you want to configure and click Add. 

The MWTM adds the selected event to the list of configured events and creates a Default entry for the 
event in the left pane.

Step 6 Click the Default entry in the left pane.

The Event Configuration pane appears in the right pane.

Move Up

Caution Do not move the Normal severity from the top of this list! Moving this 
severity category lower in the list will negatively impact the handling of 
events in the MWTM.

Moves the selected severity up in the list.

The order of the severities that appear in this list determines the sort order of the 
Severity column in the event table (see Event Table, page 9-5).

To move a severity higher in the order of severities, click Move Up.

Move Down

Caution Do not move the Normal severity from the top of this list! Moving this 
severity category lower in the list will negatively impact the handling of 
events in the MWTM.

Moves the selected severity down in the list.

The order of the severities that appear in this list determines the sort order of the 
Severity column in the event table (see Event Table, page 9-5).

To move a severity lower in the order of severities, click Move Down.

Field or Button Description
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Step 7 Configure the event by adjusting the parameters.

Step 8 To delete an event, right-click the event in the left pane and click Delete.

The Event Configuration pane contains:

Field or Button Description

Name Name of the event, such as cItpRouteStateChange. You cannot change this field.

Event Keys and 
Setting

Names of the event keys, such as RouteDestinationState, and their settings, such 
as False.

You cannot change the names of the event keys, but you can change their settings. 
To change an event key setting, select a new setting from the drop-down list box. 
For example, you can change the setting for RouteDestinationState from 
Accessible to Unknown.

Category Category of the event, such as Trap.

To change the category, select a new category from the drop-down list box. 

Severity Severity of the event, such as Normal.

To change the severity, select a new severity from the drop-down list box.

Note The order of the severities affects the sort order of the severities in the 
MWTM client tables.

Event Name User-specified name for the event, that the MWTM uses for trap forwarding.

If you want the MWTM to forward this event in the form of a trap to another host, 
you can specify a new, more meaningful name for the event. The new name can 
be from 1 to 30 characters, and can contain any letters (upper- or lowercase), any 
numbers, and any special characters. If you do not specify a new name, the 
MWTM uses the default name, MWTM.

For more information about trap forwarding, see Forwarding Events as Traps to 
Other Hosts, page 9-40.

Message Message text associated with the event.

To change the message text, type over the message text.

You can also insert variable text in the message. To do so, right-click in the 
message text area. A popup menu of the valid substitutions for this event appears. 
To insert a variable in the text area, select from the popup menu.
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Help File Help file associated with the event.

By default, the MWTM provides extensive type-specific help for events. 
However, you can use the MWTM to provide your own enterprise-specific 
instructions to operators in the help file.

To change the help file, create a new HTML help file or change the default 
MWTM help file. If you installed the MWTM in:

• The default directory, /opt, then the default help files are in the 
/opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• A different directory, then the default help directory and files are located in 
that directory.

If you use an MWTM help file as a basis for your help file, rename it when you 
save it; do not use the existing MWTM name. If you do, the next time you install 
the MWTM, the MWTM overwrites the file and you lose your changes.

When you have created your new help files, store them in the 
/opt/CSCOsgm/apache/share/htdocs/customHelp directory. This directory and 
its contents are preserved when you upgrade to a new MWTM release. If you do 
not store your new help files in the /customHelp directory, the files are lost the 
next time you upgrade to a new MWTM release.

When you have created your new help files and stored them in the /customHelp 
directory, enter the new help file path and filename in the Help File field.

After you deploy the new event settings and restart the MWTM server, whenever 
you display help for the trap, the MWTM shows your new, custom help file.

Open Opens the help file associated with the event.

To see the help file, click Open. The MWTM shows context-sensitive help for 
the selected event in a separate web browser.

Action: Run Automation command or script for the event that a UNIX process runs.

You use the MWTM to automate events. That is, you can configure the MWTM 
to call a UNIX script to drive automatic paging or e-mail, for example, whenever 
the MWTM logs an event for which you have defined an automation script.

To configure automation for an event, enter a Run line with this format:

UNIXCommand EventParameters

where:

• UnixCommand specifies either a binary command name or a shell script.

• EventParameters are information from the event that the MWTM sends to 
UnixCommand as parameters. The set of EventParameters is the same as the 
set of Message element parameters, and they are specified the same way.

Field or Button Description
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Action: Run 
(continued)

For example, this Run line:

/users/johndoe/auto-inhibit.exp $NodeDisplayName $User

causes these automatic actions whenever the MWTM logs the associated event:

• The MWTM spawns a UNIX process to execute the 
/users/johndoe/auto-inhibit.exp script.

• The MWTM passes the $NodeDisplayName and $User parameters to the 
script.

After you deploy the new event settings and restart the MWTM server, the 
specified event causes the automation script to run.

When configuring automation for events, remember:

• Detailed information about event automation scripts, including the times 
they start and stop and any output produced by the scripts, is recorded in the 
MWTM system event automation log file (see Viewing the Event 
Automation Log, page 11-21).

• The MWTM event automation scripts run separately from all other MWTM 
processes.

• If the MWTM logs more than one automated event in rapid succession, the 
MWTM runs each automation script sequentially, not in parallel. The 
MWTM spawns a new UNIX process for each script, and waits for it to 
complete before running the next script.

• By default, the MWTM allows an event automation script to run for 
300 seconds (5 minutes) before canceling the script and moving on to the 
next script. To change the maximum run-time for event automation scripts, 
see Changing Event Limits, page 9-30.

Action: Poll 
(available only for 
Trap events)

Check box indicating whether MWTM should poll the associated nodes. If you:

• Want MWTM to poll the nodes, check the check box. 

• Do not want MWTM to poll the nodes, uncheck the check box.

Action: Send Trap Check box indicating whether the MWTM should forward the event as a trap to 
other systems. If you:

• Want MWTM to forward the event, check the check box.

• Do not want MWTM to forward the event, uncheck the check box. This is 
the default setting.

Raise Alarm

Caution This feature is for advanced users (Cisco developers and third-party 
integrators).

If the Raise Alarm check box is checked, then, when this event happens, an alarm 
appears in the Supplemental Alarms table.

Field or Button Description
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Forwarding Events as Traps to Other Hosts
You use the MWTM to forward MWTM events to other hosts, in the form of SNMP traps. This operation 
enables the MWTM to integrate with high-level event- and alarm-monitoring systems such as the Cisco 
Info Center (CIC). These systems can provide a single high-level view of all alarm monitoring in your 
network, making it easier to detect and resolve problems.

To forward MWTM events to other hosts:

Step 1 Specify the list of SNMP servers, or hosts, to which you want the MWTM to forward traps (see 
Specifying a List of SNMP Servers for Trap Forwarding, page 9-32).

Step 2 Specify the events you want to forward, using one of these procedures. To forward:

a. All MWTM events, click the Send a trap for all events radio button in the SNMP Servers 
Configuration window of the MWTM Event Editor. For more information, see Specifying a List of 
SNMP Servers for Trap Forwarding, page 9-32.

b. Only selected events, edit the events in the MWTM Event Editor and check the Send Trap check 
box. For more information, see the description of the Send Trap field in Configuring Trap, Status 
Alarm, or User Action Events, page 9-36.

Step 3 (Optional) Specify new, more meaningful names for the events that you want to forward. If you do not 
specify a new message name for an event, the MWTM uses the default message name, MWTM. For more 
information, see the description of the Message Name field in Configuring Trap, Status Alarm, or User 
Action Events, page 9-36.

Step 4 Save your new event settings, deploy them to the MWTM server, and restart the MWTM server.

Note For more details, see the Cisco Mobile Wireless Transport Manager 6.0 OSS Integration Guide.

Correlate

Caution This feature is for advanced users (Cisco developers and third-party 
integrators).

When you check the this check box, you can then define a key in the Key field.

Key

Caution This feature is for advanced users (Cisco developers and third-party 
integrators).

You can define a key to correlate appropriate events. The EPM notification 
includes this key for use by the north-bound system. Right-click in the text field 
to select a key.

Disable Check box to disable this event without removing the event configuration from 
the /opt/CSCOsgm/etc file.

Errors Error messages associated with the event. Correct all errors before deploying the 
new event configuration.

Field or Button Description
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Setting Sounds for Events at an MWTM Client
You use the MWTM to create and change event sound filters for the MWTM client. Event sound filters 
determine the sounds that the MWTM client plays when specific events are logged. The MWTM client 
plays the sounds even if the Event window is not currently visible.

On Solaris and Linux systems, the root user can access the sound feature from a local or remote device. 
However, users other than the root user must use a local device and client, not a remote MWTM client 
accessed by using the xhost + UNIX command.

This section includes:

• Listing Event Sound Filters, page 9-41

• Creating a New Event Sound Filter, page 9-43

• Adding a Sound File to the MWTM, page 9-45

• Changing an Existing Event Sound Filter, page 9-45

• Deleting an Event Sound Filter, page 9-46

• Playing and Muting Event Sounds, page 9-46

Listing Event Sound Filters
You use the MWTM to change the list of event sound filters that the MWTM client applies to events, or 
prevent the MWTM client from playing sounds for events.

To work with the list of event sound filters, choose Tools > Event Sounds from the MWTM main menu. 
The Event Sound Filters List dialog box appears.

Figure 9-9 Event Sound Filters List Dialog
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The Event Sound Filters List dialog box lists all event sound filters that have been defined.

Related Topics:

• Setting Sounds for Events at an MWTM Client, page 9-41

• Managing Events, page 9-1

Field or Button Description

Sound filters 
applied in 
order

Indicates the order in which sound filters are to be applied, from top to bottom. That 
is, if an event matches two or more filters in the list, the top-most filter determines 
the sound that the MWTM client plays.

This field is blank until you have created at least one new sound filter for events.

Move Up Moves the selected event sound filter up in the Sound filters applied in order list.

Move Down Moves the selected event sound filter down in the Sound filters applied in order list.

New Opens the Event Sound Filters dialog box, which you use to create a new event sound 
filter.

Edit Opens the Event Sound Filters dialog box, which you use to change an existing event 
sound filter in the Sound filters applied in order list.

Delete Deletes the selected event sound filter from the Sound filters applied in order list.

Mute Sounds Check box indicating whether the MWTM client should play event sounds. To:

• Play event sounds, check the check box. This is the default setting.

• Not play event sounds, uncheck the check box.

OK Applies any changes you made to the event sound filters list and closes the Event 
Sound Filters List dialog box. When you are satisfied with the changes you made to 
the event sound filters list, click OK.

Apply Applies any changes you made to the event sound filters list without closing the Event 
Sound Filters List dialog box.

Cancel Closes the Event Sound Filters List dialog box without applying any changes to the 
event sound filters list.

Help Shows online help for the current window.
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Creating a New Event Sound Filter
You use the MWTM to create a new event sound filter. Open the Event Sound Filters List dialog box, as 
described in Listing Event Sound Filters, page 9-41, then click New. The Event Sound Filters dialog box 
appears.

Figure 9-10 Event Sound Filters Dialog

The Event sound filters dialog box contains:

Button or Field Description

Filter Name Name of the event sound filter file.

Enter a name for the filter, then specify filter criteria for this event sound filter in the 
Event Sound Filter Criteria field.

Event Sound 
Filter Criteria

Table listing the filter criteria for this event sound filter. To add a criteria, select 
options from the drop-down list boxes:

• To filter based on message text:

a. Select Message Text from the first drop-down list box.

b. Select Contains, Equals, Does Not Contain, or Does Not Equal from the 
second drop-down list box.

c. Enter the message text in the character string field.

• To filter based on event severity:

a. Select Severity from the first drop-down list box.

b. Select Equals or Does Not Equal from the second drop-down list box.

c. Select a severity, such as Normal, from the third drop-down list box, the 
message text.



 

9-44
User Guide for the Cisco Mobile Wireless Transport Manager 6.0

OL-9118-03

Chapter 9      Managing Events
  Setting Sounds for Events at an MWTM Client

Related Topics:

• Listing Event Sound Filters, page 9-41

• Managing Events, page 9-1

Event Sound 
Filter Criteria
(continued)

• To filter based on event category:

a. Select Category from the first drop-down list box.

b. Select Equals or Does Not Equal from the second drop-down list box.

c. Select a category, such as Status or Purge, from the third drop-down list 
box, the message text.

• To filter based on the name of the node associated with the event:

a. Select Node from the first drop-down list box.

b. Select Equals or Does Not Equal from the second drop-down list box.

c. Select a node from the third drop-down list box. The MWTM lists all nodes 
that have been discovered in the drop-down list box.

More Adds one or more additional filter criteria to the event sound filter.

To add a filter criteria to the event sound filter, click More. The MWTM adds a new 
criteria to the bottom of the list.

Fewer Removes one or more filter criteria from the event sound filter.

To remove a filter criteria from the event sound filter, click Fewer. The MWTM 
deletes the last criteria in the list.

Play this 
sound:

Drop-down list box indicating the sound to play if an event matches this event sound 
filter.

The MWTM client sound files are stored in the MWTM client’s /sounds directory. If 
you installed the MWTM client:

• For Solaris/Linux in the default directory, /opt, then the sound file directory is 
/opt/CSCOsgmClient/sounds.

• For Windows in the default directory, /Program Files, then the sound file 
directory is C:\Program Files\MWTMClient\sounds.

• In a different directory, then the sound file directory is located in that directory.

To add a sound file to the MWTM, add it to the /sounds directory (see Adding a Sound 
File to the MWTM, page 9-45).

Play Plays a sample of the sound selected in the Play this sound drop-down list box.

OK Applies any changes you made to the event sound filter criteria and closes the Event 
Sound Filters dialog box.

When you are satisfied with the changes you made to the event sound filters, click 
OK.

Cancel Closes the Event Sound Filters dialog box without applying any changes to the event 
sound filter criteria.

Help Shows online help for the current window.

Button or Field Description
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Adding a Sound File to the MWTM
You can add sound files to an MWTM client. The MWTM clients can play these sound file formats: 

• AIFC 

• AIFF 

• AU

• SND

• WAV

Note WAV files encoded using MPEG Layer-3 are not supported.

The MWTM client sound files are stored in the MWTM client’s /sounds directory. If you installed the 
MWTM client:

• For Solaris/Linux in the default directory, /opt, then the sound file directory is 
/opt/CSCOsgmClient/sounds.

• For Windows in the default directory, /Program Files, then the sound file directory is 
C:\Program Files\MWTMClient\sounds.

• In a different directory, then the sound file directory is located in that directory.

If for some reason the MWTM cannot play a specified sound file, the MWTM plays a default beep. For 
example, the MWTM cannot play a sound file if one of these conditions exists:

• The file has been moved or deleted from the /sounds directory.

• The /sounds directory has been deleted or cannot be found.

• Some other application is using all of the sound resources.

• No sound card is present.

Related Topics:

• Creating a New Event Sound Filter, page 9-43

• Managing Events, page 9-1

Changing an Existing Event Sound Filter
You use the MWTM to change an existing event sound filter. Open the Event Sound Filters List dialog 
box, as described in Listing Event Sound Filters, page 9-41, select the filter in the Sound filters applied 
in order list, then click Edit. The MWTM shows the Event Sound Filters dialog box (Figure 9-9), 
populated with the selected filter’s settings.

Change the settings as needed, then click OK. The MWTM applies your changes and closes the Event 
Sound Filters dialog box.
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Deleting an Event Sound Filter
You use the MWTM to delete an existing event sound filter. Open the Event Sound Filters List dialog 
box, as described in Listing Event Sound Filters, page 9-41, select the filter in the Sound filters applied 
in order list, then click Delete. The MWTM deletes the selected filter.

Playing and Muting Event Sounds
You use the MWTM to specify whether you want the MWTM client to play event sounds. To do so, open 
the Event Sound Filters List dialog box, as described in Listing Event Sound Filters, page 9-41. To:

• Play event sounds, uncheck the Mute Sounds check box. This is the default setting.

• Not play event sounds, check the Mute Sounds check box.

Displaying Alarms
You use the MWTM to view a summary of all currently active alarms in your network, including the 
current status of the associated network object. An active alarm is a network object with this status:

• A link, signaling gateway-mated pair, or application server process that is Warning (yellow) or 
worse and is not Ignored.

• A linkset, signaling point, node, application server, interface, card, or backhaul that is Pending (red) 
or worse and is not Ignored.

To see a summary of all currently active alarms, click Alarms in the navigation tree left pane. The 
MWTM shows the Active Alarms window in the right pane (see Figure 9-11).

• Right-click Alarms in the navigation tree to display the right-click menu for all alarms (see 
Right-Click Menu for All Alarms, page 9-49).

• Right-click an alarm in the content area in the right pane to display the right-click menu for a 
specific alarm (see Right-Click Menu for a Specific Alarm, page 9-49).

Figure 9-11 Active Alarms Window
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The Active Alarms window provides basic information about all currently active alarms in your network, 
that are not excluded from your current view. The MWTM updates the information in the window at least 
once every minute.

To see the tooltip for each column in the table, place the cursor over a column heading.

If a cell is too small to show all of its text, place the cursor over the cell to see the complete text in a 
tooltip.

You can resize each column, or sort the table based on the information in one of the columns. By default, 
this table is sorted by Age, with the most recent alarms at the top, and the MWTM shows all of the 
columns in the table except Last Status Change.

• To display hidden columns, right-click in the table heading and check the check boxes for the 
columns you want to display.

• To hide columns, right-click in the table heading and uncheck the check boxes for the columns you 
want to hide.

For more information about resizing, sorting, displaying, or hiding columns, see Navigating Table 
Columns, page 5-23.

The Active Alarms window contains:

Column Description

Type Type of network object associated with the selected alarm.

To see all higher-level alarms associated with the network object, select the 
turner beside the object. The MWTM shows the higher-level alarms 
underneath the selected alarm. For example, if you select the turner beside a 
link, the MWTM shows the alarms for the linkset, signaling point, and node 
associated with that link.

Name Name of the network object associated with the selected alarm.

Status Current status of the network object associated with the selected alarm. 
Possible values include:

• None: Black

• Unknown: Red

• Unavailable: Red

• Inactive: Red

• Failed: Red

• Down: Red

• Blocked: Red

• Pending: Red

• Warning: Yellow

• Shutdown: Blue

• Inhibited: Blue
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Status (continued) • InhibitLoc: Blue

• InhibitRem: Blue

• Discovering: Cyan

• Polling: Cyan

• Waiting: Gray

• Unmanaged: Gray

• Active: Green

For detailed definitions of each status for each type of network object, see 
Status Definitions, page E-1.

Status Reason Reason for the current status of the network object associated with the 
selected alarm.

For a full list of possible reasons, see the stateReasons.html file. If you 
installed the MWTM in:

• The default directory, /opt, then the file is located at 
/opt/CSCOsgm/apache/share/htdocs/eventHelp directory.

• In a different directory, then the help directory and file are located in that 
directory.

If the cell is too small to show all of the status reason, place the cursor over 
the cell to see the full status reason in a tooltip help popup.

The status reasons are listed in order of decreasing magnitude. If two or more 
reasons apply, the reason of greatest magnitude appears.

If the status reason is Unsupported Configuration, correct the configuration 
and enter the mwtm cleandiscover command to delete all current network 
data and begin a discovery of the network. If the status reason remains 
Unsupported Configuration, enter the mwtm clean command to restore the 
MWTM server to a state that would exist after a new installation of the 
MWTM, excluding the log files, which the MWTM retains. To also remove 
the log files, enter the mwtm cleanall command. For more information on 
the use of these commands, see Command Reference, page B-1.

Last Status Change Date and time that the status of the network object associated with the 
selected alarm last changed.

Age Age of the selected alarm, in days, hours, and minutes.

Column Description
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Right-Click Menu for All Alarms
To see the right-click menu for all active alarms, select Alarms in the navigation tree and right-click the 
mouse button. 

Right-Click Menu for a Specific Alarm
The active alarms table provides a subset of the MWTM main menu as a right-click menu. To see this 
menu, select an alarm and right-click the mouse button. 

The alarm right-click menu provides the same options as the right-click menu for the associated network 
object, plus these additional options:

Menu Command Description

Show In New Window Opens the Active Alarms window in a new window.

Back > List of Windows Navigates back to a window viewed in this session.

The MWTM maintains a list of up to 10 Back windows.

Forward > List of 
Windows

Navigates forward to a window viewed in this session.

The MWTM maintains a list of up to 10 Forward windows.

Menu Command Description

Expand All Shows all higher-level alarms associated with all network objects in the active 
alarms table.

Collapse All Does not display higher-level alarms in the active alarms table.

Edit Notes Opens the Edit Event dialog box for the selected event.

Clear Event Icon Deletes the event icon from MWTM displays for the selected object, for this 
MWTM client only. The actual events are not deleted from the MWTM, only the 
event icon for the selected object for this MWTM client.

This option is grayed-out if the selected object has no associated event icon.

Delete Deletes the selected alarm.

Go To > Object Shows the window for the object associated with the selected event.

If no object is associated with the event, this option is not visible.

Back > List of 
Windows

Navigates back to a window viewed in this session.

The MWTM maintains a list of up to 10 Back windows.

Forward > List of 
Windows

Navigates forward to a window viewed in this session.

The MWTM maintains a list of up to 10 Forward windows.

View > Status 
Contributors

Displays the Status Contributors pane for the selected object. Objects in this pane 
contribute to the status of the selected object.

View > Details Displays the Details pane for the selected object.

View > Notes Displays the Notes pane for the selected object. If there are no notes associated 
with the selected object, this option is grayed-out.
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  Displaying Alarms

Caution The alarms visible in the active alarms table are the actual network objects in the MWTM. Options you 
select in the right-click menu affect the object in the MWTM. For example, if you delete a node in the 
active alarms table, you delete that node from the MWTM database.

View > 
Troubleshooting

Displays the Troubleshooting pane for the selected object. 

If you have implemented MWTM User-Based Access, this option is available to 
users with authentication level Network Operator (level 3) and higher.

View > Recent 
Events

Displays the Recent Events pane for the selected object and any associated 
network objects.

Archived Events > 
Status Changes

Displays the archived status changes in a web browser.

Archived Events > 
SNMP Traps

Displays the archived SNMP traps in a web browser.

Archived Events > 
Status Changes and 
SNMP Traps

Displays both the archived status changes and archived SNMP traps in a web 
browser.

Ignore Ignores the selected object at the next polling cycle.

If you have implemented MWTM User-Based Access, this option is available to 
users with authentication level Power User (level 2) and higher.

Menu Command Description
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